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About This Guide

IMPORTANT! Before using this product, read and understand the information in the
“Safety” appendix in this document.

Revision history

Revision Date Description

B.0 10 January 2014 e Added support for lon PI"Controls
200 Kit.

e Updated recommendation for
replacing Wash 2 Bottle in
“Guidelines for best results” on
page 25.

A0 19 November 2013 New user guide.

Purpose of the guide

The lon PI"" Sequencing 200 Kit v3 User Guide (Pub. no. MANO0009136) provides
protocols and reference information for using the Ion PI" Sequencing 200 Kit v3 (Cat.
no. 4488315) on the Ion Proton™ System with the Ion PI" Chip Kit v2 (Cat. nos.
4482321 and 4482413).

lon PI™ Sequencing 200 Kit v3 User Guide 7
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Product information

)

CAUTION! ABBREVIATED SAFETY ALERTS. Hazard symbols and hazard
types specified in procedures may be abbreviated in this document. For the
complete safety information, see the “Safety” appendix in this document.

IMPORTANT! Before using this product, read and understand the information in the
“Safety” appendix in this document.

Product description

The Ion PI"* Sequencing 200 Kit v3 includes reagents and materials for sequencing up
to 200-bp average insert libraries using the Ion PI"" Chip Kit v2 (Cat. nos. 4482321 and
4482413) on the Ion Proton System. The sequencing kit also includes components for

cleaning and initializing the instrument.

The kit is designed to sequence templates that have been amplified on Ion PI"" Ton
Sphere " Particles (ISPs) using the Ion PI'"' Template OT2 200 Kit v3 (Cat. no. 4488318).
Sufficient reagents and materials are provided for performing eight initializations and
eight sequencing runs.

Sequencing type Number of flows Number of runs | Average sequencing run
per kit time
200-base read 500 8 2.6 hours
150--base -read 400 8 2.1 hours
100--base -read 260 8 1.4 hours

Note: Some applications allow for shorter flow times and shorter read lengths. The

number of flows can be reduced in increments of 20. Contact Technical Support for
more information.

Library kit compatibility

The Ion PI'"" Sequencing 200 Kit v3 is optimized for 200-base-read libraries of any
type, including Ion AmpliSeq ' Exome libraries.

lon PI™ Sequencing 200 Kit v3 User Guide



Template kit compatibility

Software compatibility

Contents and storage

Chapter 1 Product information §&

-
o
§
/l

d

S
(™
85

&
B

Template kit compatibility

The Ion PI"" Sequencing 200 Kit v3 must be used with the Ion PI"" Template OT2 200
Kit v3 (Cat. no. 4488318). Select the Ion PI"" Template OT2 200 Kit v3 when creating a

Planned Run.

This sequencing kit is compatible with Torrent Suite™ Software Version 4.0.2 and
later. Be sure to update your Torrent Suite” Software as well as your Ion Proton’

Sequencer software before using this kit.

M

IMPORTANT! Do not mix components with components from any other Ion
sequencing kits. Life Technologies has validated this protocol using these specific
materials. Substitution may adversely affect system performance.

The Ion PI" Sequencing 200 Kit v3 (Catalog no. 4488315) contains the following boxes

and components:

lon Proton™ Sequencing Supplies Kit (Part no. 4488314)

Components Color Quantity Volume Storage
lon Proton” Reagent Tube Caps — 16 caps — 15°C to 30°C
lon Proton” Wash Bottle Sippers Gray 2 packs of -

4 sippers each
lon Proton” Reagent Tube Sippers Blue 2 packs of -
32 sippers
each
lon Proton” Reagent Tubes with labels (140 mL) — 16 packs of -
4 tubes each
lon Proton” Wash 2 Bottle with label (2 L) - 1 bottle -
lon PI"™ Sequencing Reagents 200 v3 (Part no. 4488316)

Components Color Quantity Volume Storage
lon PI" dGTP Black 1 tube 240 pL -30°C to -10°C
lon PI" dCTP Blue 1 tube 240 L
lon PI"™ dATP Green 1 tube 240 plL
lon PI" dTTP Red 1 tube 240 pL
lon PI" Sequencing Polymerase v3 Yellow 1 tube 48 L

lon PI™ Sequencing 200 Kit v3 User Guide




Chapter 1 Product information

Required materials and equipment

lon PI" Sequencing Reagents 200 v3 (Part no. 4488316)

Components Color Quantity Volume Storage
lon PI"™ Sequencing Primer White 1 tube 160 pL
lon PI" Control lon Sphere™ Particles Clear 1 tube 40 pL

lon PI"™ Sequencing Solutions 200 v3 (Part no. 4488317)

Components Color Quantity Volume Storage
lon PI" W2 Solution v3 - 2 bottles 320mLeach | 2°Cto8°C
lon Cleaning Tablet — 2 bags of - Store the lon

4 tablets each SoTtljtiZszv3
lon PI™ 1X W3 Solution — 1 bottle 400 mL prote;ted from
lon PI" Annealing Buffer — 1 bottle 30 mL Hont
lon PI" Loading Buffer Brown 1 tube 80 pL
lon PI" Foaming Solution (10% Triton® X-100) Violet 1 tube TmL

lon Chip Preparation Solution (Part no. 4488159)
Components Quantity Volume Storage
lon Chip Preparation Solution 2 vials 1.3 mL each -30°C to -10°C
lon Proton™ Chip Adapters (Part no. 4485416)
Components Quantity Volume Storage
lon Proton™ Chip Adapters 8 adapters - 15°C to 30°C

Required materials and equipment

The following tables list required materials and equipment that are not provided with
the Ton PI'" Sequencing 200 Kit v3.

Note: Life Technologies has validated this protocol using these specific materials.

Substitution may adversely affect system performance.

Table 1 Required materials and equipment for sequencing

O Description Supplier Catalog no. Quantity
lon PI"™ Chip Kit v2 8-Pack (2 boxes of 4 chips each) Life 4482321 8 chips
lon PI"™ Chip Kit v2 4-Pack Technologies 4482413 4 chips
lon Proton™ System (instrument and server) and all Life 4476610 1

included accessories

Technologies

10
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Required materials and equipment

=

Description Supplier Catalog no. Quantity
lon Chip™ Minifuge (120 V or 230 V) Life 4479672 (120V) 1
Technologies or
4479673 (230V)
lon Proton™ Rotor and Buckets Kit Life 4482578 1
Technologies
lon PI" Controls Kit v2 or Life 4482414 or 1
lon PI"™ Controls 200 Kit [" Technologies 4488985
Tank of compressed nitrogen (grade 4.5, 99.995% pure or Major — —
better) Laboratory
Supplier (MLS)
Multistage (dual-stage) gas regulator (0-50 psi, 2-3 Bar VWR 55850-422 Tor2
output) International
(Optional)1/8" x 1/4" stem reducing coupler (only McMaster 5779K699 1 per wash
required if using a separate tank for the wash station)
Uninterruptable Power Supply (UPS) (2! MLS — 1
ELGA® PURELAB® Flex 2 Water Purification System or Life 4474525 or 1
ELGA® PURELAB® Flex 3 Water Purification System or | 1 0'"0!091€S | 449,504 or
Equivalent 18 MQ water system MLS
NaOH (10 M) molecular biology grade MLS — —
Isopropanol (100%) MLS — —
Nuclease-free water molecular biology grade MLS - —
0.22-pm or 0.45-pm vacuum filtration system and filters MLS - —
Microcentrifugel®! MLS — 1
P2, P10, P20, P200, P1000 pL pipette set and filtered tips MLS — 1 set
25-mL or 50-mL serological pipettes or MLS — Varies
100-mL graduated cylinder
(If using serological pipettes) Pipet-Aid® pipetter Drummond 4-000-110 1
Scientific
Rainin® Pipet-Lite® XLS with RFID LTS 2 pL to 20 L Rainin L-20XLS 1
Rainin® Pipet-Lite® XLS with RFID LTS 10 pL to 100 uL Rainin L-100XLS 1
Rainin® StableRak™ LTS tips 2-20 ulL Rainin SR-L20F —
Rainin® StableRak™ LTS tips 200 pL Rainin SR-L200F —
0.2-mL MAXYMum Recovery® Thin Wall PCR Tubes, Flat Axygen PCR-02-L-C Varies
Cap (do not use polystyrene tubes)

lon PI™ Sequencing 200 Kit v3 User Guide
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Required materials and equipment

0 Description Supplier Catalog no. Quantity
1.5-mL or 1.7-mL microcentrifuge tubes MLS — Varies
Glass bottles (1 L) MLS — -
Ice buckets and ice — — —
Aluminum heat block, capable of maintaining 50°C MLS - —
Vortex mixer with a rubber platform MLS — 1
Thermal cycler with a heated lid MLS — 1
Standard laboratory vacuum line or vacuum pump MLS - 1
Liquid trap MLS - 1
Tygon® tubing 14/ MLS — 1

1 For installation and troubleshooting.

(2 For laboratories that experience frequent power outages or line voltage fluctuations, we recommend that you use an uninterruptable power
supply that is compatible with 2500 W output or higher.

Bl Must fit standard 1.5- and 0.2-mL microcentrifuge tubes and generate 15,500 x g.

4] As needed to connect laboratory vacuum to liquid trap and liquid trap to P200 pipette tip.

Table 2 Optional materials and equipment for sequencing

0 Description Supplier Catalog no. Quantity

The following may be required to verify and adjust the pH of the W2 Solution during Initialization
Orion® 3-Star Plus pH Benchtop Meter Kit with electrode, Thermo 1112003 1
electrode stand, and calibration buffers (or equivalent) Scientific
1 N HClL MLS - Varies
Magnetic stirrer (must hold 2-L bottle) MLS - 1
Magnetic stir bar (4 cm) MLS — 1
Squirt bottle MLS - 1

12 lon PI" Sequencing 200 Kit v3 User Guide
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lon Proton Sequencer

Chip clamp

Figure 1 lon Proton” Sequencer with Reagent Tubes attached

Wash Wash Clean Clean

dGTP dCTP dATP

Waste container

Figure 2 lon Proton" Sequencer reagent compartment
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Touchscreen

Power on/off

Reagent
compartment

Wash 2

dTTP
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1] Chapter 1 Product information
1 Workflow

USB connections

Ethernet connection

Gas connector

AC input power connection )
Power switch (on/off)

Figure 3 lon Proton Sequencer connections and power switch

Workflow

Use the following workflow to perform sequencing runs with the Ion Proton'" System.

Chapter 2, “Create a Planned Run”
v

Chapter 3, “Clean and Initialize the lon Proton™ Sequencer”
“Cleaning” on page 21
v
“Initialization” on page 24

v

Chapter 4, “Load the lon PI™ Chip v2 and start the sequencing run”
“Prepare the template-positive lon PI™ lon Sphere™ Particles for sequencing” on page 32
v
“Prepare and calibrate the lon PI™ Chip v2 for loading” on page 33
v
“Load the lon PI™ Chip v2” on page 35
v

“Select the planned run and start the sequencing run” on page 37

14 lon PI" Sequencing 200 Kit v3 User Guide
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Precautions - Read before using the lon Proton™ System

Gas safety

Avoid nucleic acid
contamination

Avoid CO,
contamination

Avoid introducing
noise to
instrument
measurements

Avoid chip damage

WARNING! Ion instrumentation should be installed and operated in a well-
ventilated environment as defined as having a minimum airflow of 6-10 air
changes per hour. Assess the need for ventilation or atmospheric monitoring to
avoid asphyxiation accidents from inert gases and/or oxygen depletion, and
take measures to clearly identify potentially hazardous areas through training
or signage. Please contact your Environmental Health and Safety Coordinator
to confirm that the Ion instruments will be installed and operated in an
environment with sufficient ventilation.

IMPORTANT! A primary source of contamination is spurious DNA fragments from
previous sample processing steps. Do not introduce amplified DNA into the library
preparation laboratory or work area.

IMPORTANT! Handle nucleotides carefully to avoid cross-contamination. Always
discard gloves after removing used Sippers from the sequencer in order to avoid
cross-contamination of the nucleotides. Always discard gloves after handling
concentrated dNTP stocks. Barrier tips are required for all ANTPs pipetting steps.

IMPORTANT! Dry ice (solid CO,) should be kept away from areas where buffers,
wash solutions or sources of molecular biology grade water for the Ion Proton "
System are used. High air concentrations of subliming CO, may influence the pH of
such buffers during or after their preparation. The stability of the pH of these buffers
is a critical factor in the performance of the Ion Proton™ System.

IMPORTANT! Install the Ion Proton” System on a bench that is free from vibrations
and that is not in contact with freezers, pumps, or other equipment that can cause
vibrations. Significant vibration during sequencing may add noise and reduce the
quality of the measurements.

See the Ion Proton™ System Site Preparation Guide (Pub no. 4478733) for Ion Proton"™
System space requirements and clearances.

IMPORTANT! To avoid possible damage to the chip due to electrostatic discharge,
ground yourself before picking up a chip or placing a chip on a surface such as a lab
bench. For example, touch the metal trim on the chip compartment before inserting or
removing a chip from the chip clamp.

lon PI" Sequencing 200 Kit v3 User Guide 15



%24
) "}
ad

5

Create a Planned Run

%

N
)

ND

IMPORTANT! This sequencing kit is compatible with Torrent Suite” Software
Version 4.0.2 and later. Before proceeding, check for updates to the Torrent Suite™
Software and Ion Proton™ Sequencer software, and install the updates if available.

Note: If you are currently using Ion Reporter " Software Version 1.4 with an earlier
version of the Torrent Suite” Software, contact Technical Support for assistance with
upgrading to Torrent Suite” Software Version 4.0.2.

About planned runs

Planned runs contain all the settings used in a sequencing run, including number of
flows, kit types, barcodes used (if any), run type (e.g., DNA, RNA, amplicons), and
reference file (if any). They provide a fast and convenient way to set up and organize
your runs.

You create planned runs using the Torrent Browser and then select the appropriate
plan in the Select Planned Run screen of the Ion Proton Sequencer when you are
ready to perform the run (see “Select the planned run and start the sequencing run”
on page 37).

Note: For additional information, see the Torrent Suite” User Interface Guide 4.0.2. Go
to ioncommunity.lifetechnologies.com, select Products » Torrent Suite™, then select
Torrent Suite™ 4.0.2 Documentation.

Create a planned run

1. Open the Torrent Browser for the Torrent Suite " connected to your Ion Proton™
Sequencer.

16 lon PI" Sequencing 200 Kit v3 User Guide
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Chapter 2 Create a Planned Run X
Create a planned run

2. Select the Plan tab, select Templates, locate the application you want to run (for
example, TargetSeq) then select one of the following:

¢ Plan Run to plan a new run using one of your existing templates.

¢ Plan New Run to plan a new run using the generic template for the selected
application.

-
-

3. In the wizard, review each screen and edit as needed. Key fields are described in
“Planned run wizard: key fields” on page 18.

Note: For a complete description of each field, see the Torrent Browser User
Interface Guide.

4. When you have completed your selections, click Plan Run to save your
selections. The run is listed on the Planned Runs page under the name you

specified.

You can then select the appropriate plan when you are setting up the run on the Ion
Proton’ Sequencer. Select the plan on the Select Planned Run screen (see “Select the
planned run and start the sequencing run” on page 37).

lon PI" Sequencing 200 Kit v3 User Guide 17
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Planned run wizard: key fields

%

Planned run wizard: key fields

Field name

Description

Application

Select the sequencing application you are performing.

Run Type

Select Forward.

Template Kit

Select the kit used to prepare the templated lon PI" lon Sphere”
Particles.

Sequencing Kit

Select the lon PI™ Sequencing 200 Kit v3.

Flows

Enter the appropriate number of flows for the read length (for
example, 500 flows for 200-base-read sequencing).

Barcode Set
(optional)

If you are using barcodes with:

¢ DNA libraries: Select the lonXpress barcode set, which
includes all barcodes in the lon Xpress" Barcode Adapters
1-96 Kits.

¢ RNA libraries prepared using the lon Total RNA-Seq Kit v2:
Select the lonXpressRNA barcode set, which contains all 16
barcodes in the lon Xpress"™ RNA BC01-16 Kit.

If you are notusing barcodes with:
e DNA libraries: Leave the Barcode field blank.

¢ RNA libraries prepared using the lon Total RNA-Seq Kit v2:
Select RNA_Barcode_None from the drop-down list. This will
ensure that the proper trimming is performed on the
resulting sequence when the RNA library does not have a
barcode.

Monitor

Set thresholds for Bead Loading, Usable Sequence, and Key
Signal. In the lon Proton™ Torrent Browser Monitor » Runs in
Progress tab, an alert is displayed if the values for a run fall below
the selected thresholds.

Reference Library

Select a reference library uploaded to the Torrent Server, if any.

18
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Planned run wizard: key fields

Field name

Description

BED files

Select the Target Regions or HotSpot Regions BED file on the
Torrent Server, if any.

Plugins

Select and configure the appropriate plugins for your application.

Project

Select or add a project within which to group your run data. You
can include runs in multiple projects, and remove runs from a
project at any time.

Export

If installed and enabled, and you want to upload data to the lon
Reporter” Software, select the lon Reporter” Uploader.

Planned Run Name

Enter a name for the run.

Sample Name

e If lon Reporter” Uploader is enabled, enter each sample
name next to the appropriate barcode (if applicable), and
select the appropriate values for workflow, relation, relation
role, and set ID.

o If lon Reporter” Uploader is not enabled, enter the sample
name or names separated by commas.

lon PI™ Sequencing 200 Kit v3 User Guide
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lon Proton” Sequencer reagent positions

Wash Wash Clean Clean

dGTP dCTP dATP

Waste container

Clean and Initialize the lon Proton"

Sequencer

Wash 2

dTTP

Front row: dGTP, dCTP, dATP, and dTTP Reagent Tubes (instrument positions R1-R4)
Back row: Wash 1, Wash 3, Clean 1, and Clean 2 Reagent Tubes (instrument positions W1, W3,

C1,and C2)

Also shown: lon Proton™ Wash 2 Bottle (W2) and waste container

Before you begin

Prepare a stock of 1 M NaOH daily by diluting 10 M NaOH with 18 MQ water directly
from the purification system. Do not use water that has been collected or stored in any
other containers.. You will need 32 uL for each initialization, 1 mL for each chlorite
cleaning, and ~60 pL for each chip preparation (to prepare 600 uL of 0.1 M NaOH).

20
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Cleaning | O |
Cleaning
Materials * 18 MQ water (prepared and used directly from a water purification system, for
required example, ELGA” PURELAB® Flex 2 Water Purification System)

* Two 140-mL Reagent Tubes (provided with kit; label the Reagent Tubes C1 and
C2 before use)

e Collection tray (provided with the Ion Proton” Sequencer)

* Cleaning chip (leave chip on the instrument during cleaning)

Note: A cleaning chip is a used chip that you designate for cleaning. You can use
this chip for cleaning for up to 1 week.

e Used Sippers (from previous run or provided with the instrument)

¢ For chlorite cleaning only:

Ion Cleaning Tablet (provided with kit)

2 Reagent Tubes designated for chlorite cleaning (Relabel used C1 or C2
Reagent Tubes for this purpose)

1M NaOH

0.22-pm or 0.45-pum vacuum filtration system and filters

Cleaning schedule Run the cleaning program with 18 MQ water or chlorite solution before each
initialization according to the following schedule. Cleaning takes ~30 minutes.

Clean with: Schedule

18 MQ water e Before each initialization.

¢ [Recommended) After the last run of the day if the instrument will
not be used within 72 hours after the last run (for example, clean
after the last run before a 3-day weekend).

e Before shutting the instrument down for an extended period.

Chlorite
solution

e Once aweek (unless the instrument has not been used since the
last chlorite cleaning, in which case, clean with 18 MQ) water before
using).

e If reagents have been left on the instrument for more than 48 hours
(for example, over the weekend).

lon PI" Sequencing 200 Kit v3 User Guide 21
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§29% Chapter 3 Clean and Initialize the lon Proton™ Sequencer

18 MQ water

IMPORTANT! For the following steps, use 18 MQ water directly from the purification

cleaning system. Do not use water that has been collected or stored in any other containers.

1.

2.

3.

8.

Select Clean on the touchscreen Main Menu, then follow the instructions on the
touchscreen to perform the cleaning procedure.

When prompted, orient the cleaning chip with the notch in the bottom-front
corner, place the chip in the chip clamp, then push the metal tab back until it
clicks to engage the clamp.

Note: Do not force the chip into the clamp. If the chip does not fit easily in the
clamp, confirm that the notch is oriented as shown in the following photos.

When prompted, remove all of the Reagent Tubes and the Wash 2 Bottle:
* Remove and discard all eight 140-mL Reagent Tubes.
Note: If necessary, you can reuse the same C1 and C2 Reagent Tubes for
multiple cleanings for up to 1 week. If you reuse the C1 and C2 Reagent

Tubes, make sure the tubes are correctly labeled, and cap the tubes when
they are not installed on the instrument.

¢ Remove the Wash 2 Bottle, discard the liquid, and save the bottle for reuse in
initialization.

* Remove and replace the Sippers in the C1 and C2 positions.

IMPORTANT! Leave all other Sippers in place, these are used during
cleaning and initialization.

Remove the Waste Container, empty the waste, replace the container on the
instrument, then press Next.

Rinse the C1 and C2 Reagent Tubes twice with ~100 mL of 18 MQ water.

Add 100 mL of 18 MQ water to the C1 and C2 Reagent Tubes and install them
into the C1 and C2 positions of the Ion Proton™ Sequencer.

Place the collection tray on the instrument, direct all Sippers into the collection
tray, then press Next.

When cleaning is finished, press Next to return to the Main Menu.

Proceed to “Initialization” on page 24.

22
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Chlorite cleaning Perform chlorite cleaning weekly, and as directed in “Cleaning schedule” on page 21.

IMPORTANT! For the following steps, use 18 MQ water directly from the purification
system. Do not use water that has been collected or stored in any other containers.

1.

10.

1.

Fill a glass bottle with 1 L of 18 M(Q) water and add a Cleaning Tablet (chlorite
tablet). Allow the tablet to completely dissolve (~10 minutes).

When the tablet has dissolved, add 1 mL of 1 M NaOH and filter the solution
using a 0.22-um or 0.45-pm filter. Use the chlorite solution within 2-3 hours and
discard any unused solution after this time.

Select Clean on the touchscreen Main Menu, then follow the instructions on the
touchscreen to perform the cleaning procedure.

When prompted, secure a cleaning chip in the chip clamp.

When prompted, remove all of the Reagent Tubes and the Wash 2 Bottle:

* Remove and save the C1 and C2 Reagent Tubes for use with chlorite
solution. (Label these tubes for chlorite cleaning only and discard after the
chlorite cleaning cycle is completed; do not use these tubes for 18 MQ water
cleaning.)

* Remove and discard all other 140-mL Reagent Tubes.

* Remove the Wash 2 Bottle, discard the liquid, and save the bottle for reuse in
initialization.

* Remove old Sippers and replace with new Sippers in the C1 and C2
positions.

IMPORTANT! Leave all other Sippers in place, these are used during
cleaning and initialization.

Remove the Waste Container, empty the waste, replace the container on the
instrument, then press Next.

Add 100 mL of filtered chlorite solution to the two Reagent Tubes designated for
chlorite cleaning.

On the Ion Proton’" Sequencer, install the tubes containing chlorite solution in
the C1 and C2 positions.

Place the collection tray on the instrument, then direct all Sippers into the
collection tray. Press Next to begin cleaning.

When cleaning is finished press Next to return to the Main Menu.

Remove and discard the Reagent Tubes used for chlorite solution from the C1
and C2 positions.

Note: If necessary, you can reuse the same Reagent Tubes for multiple chlorite
cleanings for up to 1 month. If you reuse the chlorite cleaning tubes, make sure
the tubes are correctly labeled, and cap the tubes when they are not installed on
the instrument. Do not reuse chlorite cleaning tubes for 18 MQ) water cleaning.
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12.

13.

14.

15.

7298 Chapter 3 Clean and Initialize the lon Proton™ Sequencer

Rinse new C1 and C2 Reagent Tubes twice with ~100 mL of 18 MQ water.

Fill the C1 and C2 Reagent Tubes with 100 mL of 18 MQ) water, then install the
tubes into the C1 and C2 positions of the Ion Proton Sequencer.

Select Clean on the touchscreen Main Menu, then press Next to advance through
the instrument prompts until the cleaning procedure begins.

This post-chlorite cleaning step with 18 MQ water ensures that any residual
chlorite solution is flushed from the Ion Proton™ Sequencer.

When post-chlorite cleaning is complete, press Next to exit Cleaning and return
to the Main Menu.

Proceed to “Initialization” on page 24.

Initialize the instrument before each run. Initialization takes ~90 minutes.

Note: For additional information about Initialization, see Appendix A,
“Troubleshooting”.

Materials provided in the kit

140-mL Reagent Tubes for W1, W3, and dNTP reagents

Note: Use the labels provided with the kit to label the Reagent Tubes.
Sippers

Ion PI" dGTP, dCTP, dATP, and dTTP

Ton PI" W2 Solution v3

Ion PI'"" 1X W3 Solution

Other materials and equipment

Used or new chip

IMPORTANT! Use a chip from a sequencing run performed in the last two days.
If no sequencing was performed in the last two days, use a new chip for
initialization and sequencing. Do not use a cleaning chip for initialization.

18 MQ) water

1 M NaOH (prepared fresh daily)

Ice

Nitrogen gas tank, tube, and flow meter
25-mL or 50-mL serological pipette
Filtered pipette tips and pipettes

Vortex mixer

Microcentrifuge

(If necessary to adjust pH manually) pH meter, multipoint pH calibration
reagents, pH probe, and probe stand, magnetic stirrer, stir bar, and squirt bottle
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Initialization

Guidelines for
best results

IMPORTANT! Begin your run within 4 hours after initialization.

IMPORTANT! Handle nucleotides carefully to avoid cross-contamination. Always
discard gloves after removing used Sippers from the sequencer in order to avoid
cross-contamination of the nucleotides. Always discard gloves after handling
concentrated dNTP stocks. Barrier tips are required for all ANTPs pipetting steps.

Before you begin .

Begin the 1.
initialization
3.
4.
5.

Replace the Reagent Tubes and Sippers every time you initialize.

Replace the Ion Proton ~ Wash 2 Bottle after 8 initializations.

Check for updates to the Torrent Suite " Software and Ion Proton™ Sequencer
software, and install the updates if available.

Remove the dNTP stock solutions from the freezer and begin thawing on ice.

Check the tank pressure for the nitrogen gas. When the tank pressure drops
below 500 psi, change the tank.

Remove the Sippers from the W1, W2, and W3 positions. Do not remove the used
Sippers from the dNTP ports until instructed to do so.

Select Initialize on the touchscreen Main Menu.
When prompted, scan or enter the barcode on the W2 Solution bottle, or select

the Ion PI" Sequencing 200 Kit v3 from the drop-down list.

Note: If you are using a barcode scanner, press Enter barcode in the touchscreen
before scanning the W2 Solution barcode.

Secure a used chip in the chip clamp, then press Next.

The system verifies the gas pressure. If the gas pressure is low, press Yes to retry
gas-pressure verification. If the gas pressure remains low, see “Error Message:
Confirm Instrument Has Gas Pressure” on page 40.

Press Next to begin the initialization.

Begin preparing

IMPORTANT! For all the following steps, pour the 18 MQ) water directly from the

™
the lon Proton purification system into the Ion Proton ~ Wash 2 Bottle. Do not use water that has
Wash 2 Bottle been collected or stored in any other containers.
1. Upon first use of the Ion Proton" Wash 2 Bottle, add 1920 mL of 18 MQ water to
the bottle, mark the fill line, and empty the bottle.
2. Rinse the Wash 2 Bottle three times with 200 mL of 18 MQ water.
3. Insert the nitrogen gas tube into the empty Wash 2 Bottle, set the flow meter to

0.5 liters per minute (Ipm), and flow gas into the bottle for 5 minutes to purge
carbon dioxide from the container.
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While the Wash 2 Bottle is purging, prepare the Wash 1 and Wash 3 Reagent Tubes.

1.

2.

Add 32 pL of 1M NaOH solution to the Wash 1 Reagent Tube.

Add 40-50 mL of the 1X W3 Solution from the kit to the Wash 3 Reagent Tube,
measured using a serological pipette or graduated cylinder.

Install new Sippers (short Sippers with blue Luer-Lok® connectors) in the W1 and
W3 positions. Do not let the new Sippers touch other Sippers on the
instrument or any other surfaces.

Install the W1 and W3 Reagent Tubes into the W1 and W3 positions of the Ion
Proton Sequencer, place the collection tray beneath dNTP Sippers, then press
Next.

IMPORTANT! Load the Ion Proton” Wash 2 Bottle as quickly as possible to prevent
atmospheric carbon dioxide from reducing the pH of the Wash 2 Bottle solution.

1.

Shut off the gas.

Note: Keep the gas flowing to the Wash 2 Bottle until you are ready to
immediately prepare and load the bottle on the instrument.

Extend the water spigot from the water purification system into the neck of the
Wash 2 Bottle, then add water to the fill line marked on the bottle (1920 mL).

. Add 80 mL of Ion PI"" W2 Solution v3 to the Wash 2 Bottle using a serological

pipette.

Cap the bottle securely and invert five times to mix.

IMPORTANT! To prevent air exchange, keep the bottle tightly capped until it is
attached to the Ion Proton™ Sequencer.

Follow the on-screen prompts to install a new Sipper (long Sipper with gray
Luer-Lok® connector) in the cap for the Wash 2 Bottle. Do not let the Sipper
touch any surfaces.

Immediately attach the prepared Wash 2 Bottle and tighten the cap. Ensure that
the cap is screwed on tightly, then place the Wash 2 Bottle in the reagent
compartment before you continue.

Direct sippers to the collection tray, then press Next to continue initialization.
The Ion Proton™ System tests the tubes for leaks, fills the Wash 1 Reagent Tube,
adjusts the pH of the Wash 2 Solution, then dilutes the Wash 1 Reagent Tube
solution to the optimal concentration for the sequencing run. This procedure
takes ~40 minutes.

Note: If aleak or error occurs during the automatic pH process, see Appendix
A, “Troubleshooting”.
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Initialization

IMPORTANT! In the following steps, handle the nucleotides carefully to avoid cross-
contamination and ensure that the correct ANTP solution is installed in each position
on the Ton Proton” Sequencer.

1.

After each deoxyribonucleotide (ANTP) stock solution has thawed, vortex to mix
and centrifuge to collect the contents. Keep dNTP stock solutions on ice
throughout this procedure.

Use the labels provided with the kit to label four new 140-mL Reagent Tubes as
dGTP, dCTP, dATP, and dTTP.

After the wash solutions have initialized, follow the on-screen prompts to
remove the used dNTP Sippers and the collection tray.

Using new gloves, attach a new Sipper (short, blue Luer-Lok®) to each dNTP
port. Do not let the Sippers touch any surfaces.

Using a new filtered pipette tip, carefully transfer 20 pL of dGTP stock solution
into the bottom of the appropriate Reagent Tube, then attach the dGTP Reagent
Tube to the Ion Proton " Sequencer in the correct position (front left row) and
firmly tighten.

Similarly, prepare and install the dCTP, dATP, and dTTP Reagent Tubes by
transferring 20 uL of each dNTP stock solution to the corresponding Reagent
Tube. Use a new pipette tip for each nucleotide. Make sure to install the Reagent
Tubes in the correct order (dGTP, dCTP, dATP, and dTTP from left to right when
facing the instrument), then press Next.

IMPORTANT! Prepare and install the reagent tubes one at a time to avoid cross-
contamination.

Confirm all Reagent Tubes and Wash 2 Bottle are tightly secured, then press
Next.

Note:

. The Ion Proton " Sequencer checks the pressure of the Reagent Tubes and
Wash 2 Bottle, then adds W2 Solution to each dNTP Reagent Tube.

- If a tube or bottle leaks, you will be prompted to check that it is tightly
attached to the instrument. If it continues to leak, replace it. If you replace the
tube or bottle but the instrument does not pass the leak check, contact
Technical Support.

At the end of initialization, the Ion Proton™ Sequencer measures the pH of the
reagents.

e If every reagent is in the target pH range, a Passed screen is displayed. Press
Next to return to the Main Menu. Proceed to Chapter 4, “Load the Ion PI™
Chip v2 and start the sequencing run”.

¢ If a Failed screen appears, see “Error message: Reagent pH: Failed; Reagent
pH is displayed” on page 46.
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Guidelines for handling and loading chips

Chip handling IMPORTANT! To avoid possible damage to the chip due to electrostatic discharge,

guidelines ground yourself before picking up a chip or placing a chip on a surface such as a lab
bench. For example, touch the metal trim on the chip compartment before inserting or

removing a chip from the chip clamp.

Note: When handling chips, as a best practice, use a bare hand to touch the
grounding surface and then use the opposite hand to insert or remove the Ion PI"

Chip v2 from the chip clamp.

To place a chip in the chip clamp for cleaning, initialization, or sequencing:

Pull the metal tab forward to release the
chip clamp.

If necessary, remove the chip currently in
the clamp.
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Guidelines for handling and loading chips

Place the appropriate chip in the chip
clamp with the chip notch in the
bottom-front corner.

Note: Do not force the chip into the clamp.
If the chip does not fit easily in the clamp,
confirm that the notch is oriented as shown
in the photo.

Push the metal tab back until it clicks to
engage the clamp.

Chip notch
Exit well

Flow cell

Loading well

Loading port

Figure 4 lon PI™ Chip v2

When loading a sample:

e Place the chip on a flat, stable surface
such as a benchtop.

e Pipet the sample into the chip loading
well.

lon PI™ Sequencing 200 Kit v3 User Guide
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When injecting reagents or buffers:

Place the chip on a flat, stable surface
such as a benchtop.

With the pipette tip at a 90° angle to
the chip, press the tip firmly into the
circular loading port, and apply gentle
pressure between the pipette tip and
chip.

Pipet carefully to avoid introducing
bubbles into the chip flow cell (see
example with introduced air bubbles
on right).

After each injection, remove the
expelled liquid from the exit port,
opposite the loading port.

Air bubbles

Materials required

30

Materials provided in the Ion PI"" Sequencing 200 Kit v3

Ion PI" Control Ion Sphere ™ particles

Ton PI'"" Annealing Buffer

Ion PI'"" Sequencing Primer

Ion PI'" Loading Buffer

Ion PI"" Foaming Solution (10% Triton® X-100)
Ion PI'" Sequencing Polymerase v3

Ion Chip Preparation Solution

Ion Proton™ Chip Adapter

Other required materials and equipment

Ton PI™ Chip v2 Kit (Cat. no. 4482413 and 4482321)

Enriched template-positive Ion PI"" ISPs prepared with the Ion PI"" Template OT2
200 Kit v3 (Cat. no. 4488318)

0.1 M NaOH (~600 pL per chip, prepared fresh daily)

Standard laboratory vacuum line or vacuum pump

Liquid trap

Tygon® tubing

Note: Asneeded to connect laboratory vacuum to liquid trap and liquid trap to
P200 pipette tip.

Rainin® Pipet-Lite® XLS LTS with RFID pipette and tips

P200 and P10 pipette and filtered tips

Aluminum heat block, capable of reaching and maintaining 50°C

Vortex mixer
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Before you begin

* Molecular-biology grade nuclease-free water
* 100% isopropanol

e Thermal cycler with heated lid (programmed at 95°C for 2 minutes and 37°C for
2 minutes)

* Ton Chip" Minifuge (Cat. no. 4479672 or 4479673) for loading sample on chip
equipped with Ion Proton Rotor and Buckets (Cat. no. 4482578)

Before you begin

IMPORTANT! Use enriched, template-positive Ion PI" ISPs prepared using the Ion
PI" Template OT2 200 Kit v3.

IMPORTANT! For best results, begin your run within 4 hours after initialization
completes.

e Equilibrate the Ion PI'" Chip Preparation Solution to room temperature for at
least 20 minutes before use. Keep the tube tightly capped immediately before and
after use.

¢ Pre-heat an aluminum heat block to 50°C.
¢ Thaw the Sequencing Primer.

* Prepare the following stock solutions fresh weekly or more frequently as needed:
— 50% Annealing Buffer: In a 1.5-mL tube, combine 0.5 mL of Ion PI"
Annealing Buffer with 0.5 mL of nuclease-free water (you need 360 uL of
50% Annealing Buffer for each run).

— Flushing solution: In a 1.5-mL tube, combine 0.5 mL of 100% isopropanol
with 0.5 mL of Ion PI"" Annealing Buffer (for use in “Flush the chip and load
the Ion PI™ Sequencing Polymerase v3” on page 37; you need 200 uL of
Flushing solution for each run).

Note: You can prepare multiple 1-mL aliquots of stock solutions at the same
time, and store at room temperature. After opening an aliquot, use the contents
within 1 week. Discard any opened, unused solution after 1 week.

 Check for updates to the Torrent Suite” Software and Ion Proton™ Sequencer
software, and install the updates if available.

e Before using the Ion Chip " Minifuge for the first time, perform the procedures in
“Set up and test the Ion Chip Minifuge” on page 60.
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Prepare the template-positive lon PI" lon Sphere” Particles for
sequencing

Add lon Pl IMPORTANT! If you are performing an installation or troubleshooting run, do not
Controlmlon use enriched ISPs. Follow the procedure in “Troubleshooting using the Ion PI™ Control
Sphere " particles Ton Sphere™ particles” on page 50 to prepare the Ion PI" Control Ion Sphere
to the enriched particles for the installation or troubleshooting run.
ISPs
1. Vortex the Ion PI"" Control Ion Sphere™ particles for 5 seconds, then centrifuge
for 2 seconds before taking aliquots.
2. Add 5 pL of Ion PI" Control Ion Sphere ™ particles directly to the entire volume
of enriched, template-positive ISPs in a 0.2-mL PCR tube (non-polystyrene), then
pipet up and down to mix.
Anneal . IMPORTANT! The Ion PI'" ISPs are difficult to see. To avoid aspirating the particles in
Sequencing the following steps, orient the PCR tube the same way each time when centrifuging so
Primer to the that it is easy to know where the pellet has formed, and remove the supernatant from
enriched ISPs the top down.

1. Centrifuge the enriched, template-positive ISPs for 5 minutes at 15,500 x g.

2. Carefully remove the supernatant without disturbing the pellet, leaving 10 uL of
supernatant in the tube (visually compare to 10 uL of liquid in a separate tube).

3. Add 15 pL of Ion PI'"" Annealing Buffer for a total volume of 25 pL.

4. Add 20 pL of Ion PI"" Sequencing Primer and confirm that the total volume is
45 uL. Add Ion PI" Annealing Buffer if necessary to bring the total volume to
45 uL.

5. Briefly vortex to mix, then centrifuge briefly to collect the contents at the bottom
of the tube.

6. Program a thermal cycler for 95°C for 2 minutes and then 37°C for 2 minutes,
using the heated lid option.

7. Place the tube in the thermal cycler and run the program.

8. After cycling, add 10 uL of Ion PI"" Loading Buffer, briefly vortex to mix, then
centrifuge briefly to collect the contents at the bottom of the tube.

After cycling, the reaction can remain at room temperature while you proceed to
“Prepare and calibrate the Ion PI Chip v2 for loading” on page 33.
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Prepare and calibrate the lon PI" Chip v2 for loading

Prepare the chip
for loading

IMPORTANT! To avoid possible damage to the chip due to electrostatic discharge,
ground yourself before picking up a chip or placing a chip on a surface such as a lab
bench. For example, touch the metal trim on the chip compartment before inserting or
removing a chip from the chip clamp.

IMPORTANT! Wear gloves for the following steps. The Ion PI"' Chip Preparation
Solution is a skin irritant.

. Label a new Ion PI"" Chip v2 to identify the experiment, then place the chip on a

stable surface such as a benchtop.

Note: If the chip was not used to initialize the Ion Proton Sequencer, skip the
next step.

. If the chip was used to initialize the Ion Proton™ Sequencer, inject 100 uL

isopropanol into the chip loading port, then inject 100 uL of nuclease-free water
into the loading port and remove the expelled liquid from the opposite port.
Repeat the water flush one more time and remove the expelled liquid.

. Attach an Ion Proton™ Chip Adapter to the chip exit well (located on the side of

the chip with the notched corner, opposite the loading port; see figure below).
Press firmly to ensure the adapter is tightly engaged around the well.

Chip notch —

. Inject 200 uL of 100% isopropanol into the chip loading port, then remove the

expelled liquid from the exit well fitted with the adapter.

. Attach a P200 pipette tip to a vacuum line, insert the pipette tip into the chip

loading port, and aspirate the isopropanol from the chip flow cell for 5-10
seconds. Inspect the chip to make sure it is dry.

Note: Make sure that the Ion PI"" Chip Preparation Solution has completely
equilibrated to room temperature before proceeding to the next step.
Immediately re-cap the solution tube after use to prevent evaporation and
exposure to air.

. Inject 100 uL of Ion PI"* Chip Preparation Solution into the chip loading port,

then remove the expelled liquid from the exit well.

Note: Be careful not to introduce bubbles in the chip. If bubbles appear, repeat
this wash step.
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8 Prepare and calibrate the lon PI™ Chip v2 for loading
7. Place the chip on the flat surface of an aluminum heat block pre-heated to 50°C
and incubate for 2 minutes.
Note: Place the chip on the side of the heat block that does not contain wells, as
shown in the figure below.
8. Remove the chip from the heat block and place it on a stable surface such as a
benchtop.
9. Inject 200 pL of 100% isopropanol into the chip loading port, then remove the
expelled liquid from the exit well. Repeat the isopropanol flush one more time.

10. Inject 200 pL of nuclease-free water into the chip loading port, then remove the
expelled liquid from the exit well.

11. Inject 200 pL of 0.1 M NaOH into the chip loading port, then remove the expelled
liquid from the exit well.

12. Wait 1 minute, then inject 200 uL of nuclease-free water into the chip loading
port and remove the expelled liquid from the exit well.

13. Repeat steps 4-12 two more times, for a total of three chip washes.

14. Inject 200 uL of 100% isopropanol into the chip loading port, then remove the
expelled liquid from the exit well.

15. Pipet 100 uL of 100% isopropanol into the chip loading well (do not inject
directly into the port), then remove the liquid from the same well. This step
cleans any residue from the surface of the loading well.

16. Remove the Ion Proton” Chip Adapter from the chip.

Optional: Store The prepared chip can be stored for up to 24 hours before calibration and loading. To

the prepared chip  store the chip:

1. Attach a P200 pipette tip to a vacuum line, insert the pipette tip into the chip
loading port, and aspirate the isopropanol from the chip flow cell for 5-
10 seconds. Inspect the chip to make sure it is dry.

2. Place the dry chip back in its original anti-static bag and store at room
temperature in the dark (for example, in the box that the chip came in).

3. When you are ready to calibrate and load the chip, inject 100 uL of 100%

isopropanol into the chip flow cell, remove the expelled liquid from the opposite
port, then proceed to the next section.
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Calibrate the chip Secure the prepared chip in the chip clamp.

2. Press Run in the Main Menu, then press Next and confirm that "Cleaning fluid
lines" displays.
The instrument begins cleaning the fluid lines, then begins chip calibration.

3. During calibration, observe the chip for leaks. If there is a leak, press the Abort
button immediately to stop the flow to the chip, then see “Liquid in drip pan
below chip clamp” on page 42.

IMPORTANT! Never open the chip clamp during calibration.

4. When the chip passes calibration, remove the chip, and replace it with a cleaning
chip to prevent backflow in the fluid lines.

Note: If chip calibration fails, see “Error message: Failed: Reseat chip, then press

Next to recalibrate” on page 45.

5. Inject 100 pL of nuclease-free water two times into the chip loading port. After
each injection, remove the expelled liquid from the opposite port.

6. Inject 100 pL of isopropanol two times into the chip loading port. After each
injection, remove the expelled liquid from the opposite port.

7. Aspirate the remaining isopropanol from the chip flow cell for 5-10 seconds.
Confirm that the chip is dry.

Note: To aspirate the isopropanol, attach a P200 pipette tip to a vacuum line,
then place the pipette tip in the chip loading port.

Load the lon PI" Chip v2

Load the sample 1. Place the calibrated chip in the centrifuge bucket with the chip notch pointing
on the chip out. Place a used chip in the opposite bucket with the chip notch pointing out.
Chip notch
Chip notch

2. Dispense the entire prepared sample (55 pL) into the chip loading well (not the
chip loading port) of the calibrated chip.

Note: Some sample enters the flow cell at this point by capillary action; the
remaining sample is loaded into the flow cell during centrifugation.
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3. Centrifuge the chip for 10 minutes in the Ion Chip" Minifuge.

4. Ina1.5-mL tube, combine 49 uL of 50% Annealing Buffer with 1 puL of Foaming
Solution (10% Triton® X-100).

Note: You can prepare a bulk mixture by combining 4.9 mL of 50% Annealing
Buffer with 100 pL of Foaming Solution. The mix can be stored at 4°C and used
for up to 6 months.

5. Create foam by injecting air into the 50-pL mixture from the previous step using
a Rainin® SR-L200F pipette set to dispense 100 puL. Next, break the large bubbles
into smaller bubbles by rapidly pipetting for ~5 seconds. Repeat this step one
more time.

Note: Do not over-inject the air; the final volume of foam should be
approximately 250 uL.

6. Place the chip on a stable surface such as a benchtop, then inject 100 uL of foam
into the chip loading port. Remove the expelled liquid from the opposite port.

7. Place the chip back in the centrifuge bucket with the chip notch pointing out,
then dispense 55 uL of 50% Annealing buffer into the chip loading well (not the
chip loading port).

8. Centrifuge the chip for 30 seconds in the Ion Chip" Minifuge.

9. Place the chip on a stable surface such as a benchtop. Remove the liquid that has
accumulated in both of the chip loading wells.

10. Briefly "re-foam" the foam sample by pipetting rapidly for ~5 seconds, then inject
100 pL of foam into the chip loading port. Remove the expelled liquid from the
opposite port.

11. Place the chip back in the centrifuge bucket with the chip notch pointing out,
then dispense 55 UL of 50% Annealing buffer into the chip loading well (not the
chip loading port).

12. Centrifuge the chip for 30 seconds in the Ion Chip" Minifuge, then proceed to
flushing the chip.
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Select the planned run and start the sequencing run

Inject 100 pL of the Flushing solution into the chip loading port two times. After
each injection, discard the solution that is expelled from the opposite port.

. Inject 100 pL of 50% Annealing Buffer into the chip loading port three times. Do

not introduce air bubbles. After each injection, remove the expelled liquid from
the opposite port.

Combine 6 pL of Ion PI" Sequencing Polymerase v3 with 60 uL of 50%
Annealing buffer.

Inject 65 pL of the polymerase solution into the chip loading port and remove the
expelled liquid from the exit port. Be careful to avoid introducing air bubbles.

Allow the chip to incubate for 5 minutes, then immediately proceed to the next
steps.

Select the planned run and start the sequencing run

Complete “Prepare and calibrate the Ion PI Chip v2 for loading” on page 33 and
“Load the Ion PI Chip v2” on page 35 before performing this procedure.

1.

Secure the chip loaded with template-positive Ion PI"" ISPs in the chip clamp,
close the chip compartment lid, then press Next.

In the drop-down list, select a planned run that you created in the Torrent Suite™
Software, then press Next.

Note: You can also select Planned Run (none), then enter your run information
on the following screen, but selecting a predefined planned run is recommended.

Confirm the pre-populated settings are correct, or make changes using the
buttons and drop-down lists if necessary.

Note: If an error message appears, see “Error message: Not enough disk space
for the necessary number of flows” on page 41.

Confirm that the reagent compartment door is closed, then press Next to begin
the sequencing run.

The system calibrates the chip (~1 minute), then begins the sequencing run. If
chip calibration fails, see “Error message: Failed: Reseat chip, then press Next to
recalibrate” on page 45.

IMPORTANT! During a run, do not open the chip compartment lid or reagent
compartment door, and avoid touching the instrument. Touching the instrument
during the sequencing run may reduce the quality of the measurements.

When the run is complete, the touchscreen returns to the Main Menu. Use the Torrent
Browser to review your the results. Clean and initialize the instrument before

beginning a new run. See Chapter 3, “Clean and Initialize the Ion Proton™ Sequencer”.

4

If the instrument will not be used for more than 3 days, see “Powering off” on
page 58.
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Troubleshooting
Alarms and events

Alarms and events

Observation Possible cause Recommended action
Red "Alarms" and/or "Events" e Software updates available | Click on the red pop-up to see detailed
message in Main Menu « Connectivity issues messages.
e Instrument not detecting ¢ |f a message states "Newer Software
required files or hardware Available™:

IMPORTANT! After updates are
installed, the instrument must be
restarted.

a. Inthe Main Menu, select
Options » Updates.

b. Select the Released Updates
checkbox, then press Update.

c. When installation is complete, follow
the onscreen prompts to restart the
instrument.

Note: In some cases, the instrument
restarts automatically after software
installation.

¢ If a message states "No Connectivity to
Torrent Server”, "No Connectivity to ftp
server”, or "Network Manager not
connected”, unplug and replug the
ethernet cable, confirm that the router is
operational, and verify that the network is
up and running.

e For any other messages:

a. Power off the instrument: In the
Main Menu, select Tools » Shut
Down » Shut Down.

b. Wait 30 seconds, then press the
button on the front of instrument to
power on the instrument.

¢ |If the red "Alarms" and/or "Events”
message still appears in the main menu,
contact Technical Support.
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Troubleshooting
Status bar icon warnings

Status bar icon warnings

Observation

Possible cause

Recommended action

Chip is secured in chip clamp,
but chip icon indicates no chip
detected

e Clamp is not engaged

e Chipis not properly seated
e Chip is damaged or dirty

e |ssue with chip socket

1. Remove the chip from the chip clamp.

IMPORTANT! Do not disengage the chip
clamp if fluid is running to the chip. If you
are currently running “Clean”, “Initialize”,
or "Run”, wait until the Next button on the
touchscreen is active, or press Abort to
return to the Main Menu before
disengaging the clamp.

2. Examine the chip for damage, such as
hairline cracks, debris, or a detached flow
cell.

e If the chip is damaged, insert a new
chip in the chip clamp and engage
the clamp, look at the chip icon to
confirm the chip is detected, then
press Next or make a selection in the
Main Menu.

¢ |f no damage can be observed,
reinsert the chip in the chip clamp
and engage the clamp, look at the
chip icon to confirm the chip is
detected, then press Next or make a
selection in the Main Menu.

3. If the chip is not detected by the
instrument, there may be a problem with
the chip socket. Contact Technical
Support.

Error Message: Confirm
Instrument Has Gas Pressure

and/or

Pressure icon indicates low gas
pressure | )

Note: The correct operating
pressure is 10.5 psi.

Nitrogen gas cylinder may be
turned off or empty

1. Replace the gas tank if empty.

2. Iftank is not empty, confirm that the
cylinder has at least 500 psi and 30 psi at
the outlet of the regulator. Confirm that
all valves between the cylinder and the
lon Proton™ Sequencer are open, then
press Yes to retry verification of gas
pressure.

3. If the pressure test continues to fail,
contact Technical Support.

Temperature icon indicates
chip compartment temperature
is out of range

Thermistor in chip
compartment is damaged

Contact Technical Support.

Note: Do not perform sequencing runs until
this problem is corrected; non-optimal
temperatures in the chip compartment may
affect sequencing.
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Troubleshooting
Status bar icon warnings

Observation

Possible cause

Recommended action

Error message: Not enough
disk space for the necessary
number of flows

(The lon Proton™ System hard
drive does not contain enough
space for the planned run)

and/or

Hard drive icon indicates hard
drive is almost full { )

Data normally transfer
automatically from the hard
drive to the Torrent Server,
however this may not happen in
the case of:

¢ Data transfer manually
aborted by user

e |ssue with connectivity or
network

¢ Incorrect configuration of
the Torrent Server

Check for connectivity or network issues,
for example, unplug and replug the
ethernet cable, confirm that the routeris
operational, and verify that the network is
up and running.

If in "Select Planned Run”, select Data
Management in the touch screen,
otherwise select Tools » Data
Management from the Main Menu.

In the Data Management screen, select
All, then review the runs. If there are runs
that do not need to be transferred to the
Torrent Server (for example test or
aborted runs), select the checkbox next to
the run names, then press Delete Sel.

If there are runs that you do want to
transfer, you may need to wait until
connectivity is restored for the run to
transfer and then autodelete.

On instrument analysis icon
indicates error

Corrupt data files or file
system, for example, SSD file
array is corrupted

Power off the instrument: In the Main
Menu, select Tools » Shut Down » Shut
Down.

Wait 30 seconds, then press the button on
the front of the instrument to power on
the instrument.
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Troubleshooting
Instrument leaks

Instrument leaks

Observation

Possible cause

Recommended action

Liquid in drip pan below chip
clamp

e Chip leak
e Cracked chip

e Chip clamp not closed
properly
e Leaky fluidic seal

e Problem with the chip
clamp or socket

Press Abort to return to the Main Menu.

Use a lab wipe to absorb the liquid in the
drip pan.

Open the chip clamp, remove the chip,
and gently dab the chip with a lab wipe to
dry.

Look for damage to the chip, such as
hairline cracks, debris, or a detached flow
cell.

e If the chip is damaged, insert a new
chip in the chip clamp and engage
the clamp.

¢ |f no damage can be observed,
reinsert the chip in the chip clamp
and engage the clamp.

From the Main Menu, make the
appropriate selection (Clean, Initialize, or
Run] to start from the beginning of the
process.

If the leak persists, contact Technical
Support.

Leak from bottom of
instrument

e Waste container not
emptied

e Reagent tubes or bottle
not securely installed

Press Abort to return to the Main Menu.

Clean up all liquid beneath the
instrument.

Confirm that the waste container is not
overflowing, and empty if needed.

Confirm that all Reagent Tubes and W2
Bottle are securely fastened on the
instrument.

If the leak is due to the waste container,
Reagent Tubes, or W2 Bottle, re-start the
procedure after correcting the problem.

If there are no observable issues with the
waste container, Reagent Tubes, or W2
Bottle, contact Technical Support.

Leak on instrument tubing
(Fluid on fluid lines entering
clamp)

Fluid lines running to chip
clamp are damaged or are not
secured correctly

Contact Technical Support.
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Touchscreen

Troubleshooting
Touchscreen

Observation

Possible cause

Recommended action

Touchscreen not registering
input in correct location

Touchscreen needs to be
calibrated

e |n Main Menu, select Tools » Screen Cal,
then follow the onscreen prompts.

e [f the touchscreen continues to
malfunction after Screen Cal, contact
Technical Support.

Touchscreen inoperable

Damaged or defective
touchscreen

Contact Technical Support.

Instrument error messages

Note: Error messages are listed in alphabetical order.

Observation

Possible cause

Recommended action

Error message: Added too
much W1 to W2

Poor water quality (18 MQ
water not used directly
from water purifier, or
exposed to air for too long]

Too much W2 Solution
used to prepare Wash 2
Bottle

Incorrect solution added to
the Wash 2 Bottle

Too little NaOH added to
Wash 1 Reagent Tube

Damaged chip

1. Confirm high water quality and correct
preparation of the 1 M NaOH and Wash 2
Bottle.

2. If solution preparation is incorrect or
water quality is poor, correctly prepare
the solution(s) and/or use high-quality
water.

Clean the instrument.

Repeat instrument initialization with fresh
reagents and a new (unused) chip. (The
new chip can be used for sequencing
after initialization completes.)

Note: Once the system has added too much
NaOH, the only recourse is to clean the lon
Proton™ Sequencer and restart initialization or
to manually adjust the pH the W2 Solution (see
“Manually adjust the pH of the W2 Solution” on
page 59).

Error Message: Check Wash1

for leaks

W1 Reagent Tube seal is
not tight

Tube may be damaged or
defective

1. Remove the Wash 1 Reagent Tube, then
replace in the W1 position.

2. Make sure that the tube is securely
tightened (finger-tighten).

3. If the tube continues to leak, replace the
tube.

4. If leak check continues to fail, contact
Technical Support.
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Troubleshooting
Instrument error messages

Observation

Possible cause

Recommended action

Error Message: Check Wash?2
for leaks

e Wash 2 Bottle seal is not
tight

e Bottle may be damaged or
defective

Remove the Wash 2 Bottle, then check

the o-ring inside the Wash 2 Bottle lid. If

there is any visible damage, contact
Technical Support.

If there is no visible damage to the o-ring,
replace the Wash 2 Bottle on the
instrument. Make sure that the bottle is
securely tightened (finger-tighten).

If the bottle continues to leak, replace the
bottle.

If leak check continues to fail, contact
Technical Support.

Error Message: Check Wash3
for leaks

¢ W3 Reagent Tube seal is
not tight

e Tube may be damaged or
defective

Remove the Wash 3 Reagent Tube, then
replace in the W3 position.

Make sure that the tube is securely

tightened [(finger-tighten).

If the tube continues to leak, replace the

tube.

If leak check continues to fail, contact

Technical Support.

Error message: Chip reading
inconsistent. Please replace
chip and try again.

¢ pH response of the chip is
not uniform or reliable

e Ran out of W3 Solution or
volume too low

. Verify that there is enough W3 Solution

(approximately 50 mL) in the Wash 3
Reagent Tube and that the sipper is
secure.

If necessary, loosen the Wash 3 Reagent
Tube, tighten the sipper, and add more
W3 Solution to fill to 50 mL. Since the
system pressurization gas flows when the
reagent tube is loose, perform these
operations as quickly as possible. (The
gas is not harmful to the W3 Solution and
is not a hazard.)

If there is enough W3 Solution, replace
the chip with a new (unused) one. Secure
the chip in the chip clamp, then press
Start.

Note: The new chip can be used for
sequencing after initialization completes.

Error Message: Confirm
Instrument Has Gas Pressure

and/or

Pressure icon indicates low gas
pressure | ]

Note: The correct operating
pressure is 10.5 psi.

Nitrogen gas cylinder may be
turned off or empty

Replace the gas tank if empty.

If tank is not empty, confirm that the
cylinder has at least 500 psi and 30 psi at
the outlet of the regulator. Confirm that
all valves between the cylinder and the
lon Proton™ Sequencer are open, then
press Yes to retry verification of gas
pressure.

If the pressure test continues to fail,
contact Technical Support.
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Troubleshooting
Instrument error messages

Observation

Possible cause

Recommended action

Error message: Failed: Reseat
chip, then press Next to
recalibrate

(New chip fails calibration
before or after sample is
loaded on chip.]

¢ Reagents not loaded

e Clamp is not engaged

e Chipis not properly seated
e Chip is damaged or dirty

e |ssue with chip socket

Confirm the required reagents are loaded
on the instrument.

Press Start to re-run calibration.

If calibration fails, remove the chip from
the clamp and look for damage to the
chip, such as hairline cracks, debris, or a
detached flow cell.

e |f the chip is damaged, insert a new
chip in the chip clamp and engage
the clamp, then press Start to re-run
calibration.

e |f no damage can be observed,
reinsert the chip in the chip clamp
and engage the clamp, then press
Start to re-run calibration.

If calibration fails, run reagent check:
Press Abort, select Tools » Reagent
Check, then press Start.

¢ If the reagent check fails, re-
initialize the instrument before
beginning a sequencing run.

e If reagent check passes, contact
Technical Support.

Error message: Not enough
disk space for the necessary
number of flows

(The lon Proton™ System hard
drive does not contain enough
space for the planned run)

and/or

Hard drive icon indicates hard
drive is almost full [ )

Data normally transfer
automatically from the hard
drive to the Torrent Server,
however this may not happen in
the case of:

e Data transfer manually
aborted by user

e |ssue with connectivity or
network

¢ Incorrect configuration of
the Torrent Server

Check for connectivity or network issues,
for example, unplug and replug the
ethernet cable, confirm that the router is
operational, and verify that the network is
up and running.

If in "Select Planned Run”, select Data
Management in the touch screen,
otherwise select Tools » Data
Management from the Main Menu.

In the Data Management screen, select
All, then review the runs. If there are runs
that do not need to be transferred to the
Torrent Server (for example test or
aborted runs), select the checkbox next to
the run names, then press Delete Sel.

If there are runs that you do want to
transfer, you may need to wait until
connectivity is restored for the run to
transfer and then autodelete.
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Troubleshooting
Instrument error messages

Observation

Possible cause

Recommended action

Error message: OVERSHOT
TARGET PH: W2 pH = n.nn
Failed

Auto-pH added more NaOH
from the Wash 1 Reagent Tube
to the Wash 2 Bottle than was
needed

1. Re-initialize the instrument using new
reagents and a new chip (the chip can
then be used for sequencing).

2. Prepare 50 pL of 100 mM HCL. If you are
in the auto-pH screen, press Overshoot.
Follow the on-screen prompts to add
50 pL of 100 mM HCl to the W2 Solution.
This will lower the pH of the W2 Solution.
Press Restart to restart auto-pH.

3. If the pH is consistent with the pH of the
previous chip, manually adjust the pH of
the W2 Solution (see “Manually adjust the
pH of the W2 Solution” on page 59).

Note: If the lon Proton™ System
consistently overshoots the pH target,
add 50 pL of 100 mM NaOH to the Wash 2
Bottle prior to installing it on the
instrument. If you continue to experience
overshoot issues even after the addition
of the NaOH, contact Technical Support
for further assistance.

Error message: Please insert a
chip and press Start

Instrument cannot detect the
chip in chip clamp

See recommended action for “Chip is secured
in chip clamp, but chip icon indicates no chip
detected” on page 40.

Error message: Reagent pH:
Failed; Reagent pH is displayed

Note: Message displays on
touchscreen after Reagent
Check at end of Initialization
procedure.

One or more reagents are not
within the target pH

1. Press Restart to restart auto pH and
confirm the measurement.

2. If any reagents fail, replace the chip with
a new (unused) one. Insert the chip in the
socket, then press Restart to restart auto
pH (the new chip can be used for
sequencing after initialization completes).

3. If any reagents fail, clean and re-initialize
the instrument with fresh reagents and a
new chip.
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Troubleshooting
Instrument error messages

Observation

Possible cause

Recommended action

Error message: Reagent pH:
Failed; Reagent pH is not
displayed

Note: Message displays on
touchscreen after Reagent
Check at end of Initialization
procedure.

Chip did not calibrate

1.

Remove the chip from the clamp and look
for damage to the chip, such as hairline
cracks, debris, or a detached flow cell.

e |f the chip is damaged, insert a new
chip in the chip clamp and engage
the clamp, then press Start to re-run
reagent check.

e |f nodamage is observed, reinsert
the chip in the chip clamp and
engage the clamp, then press Start
to re-run reagent check.

If reagent check fails again, replace
the chip with a new (unused) one,
then re-run reagent check (the new
chip can be used for sequencing
after initialization completes).

If the reagent check continues to fail,
contact Technical Support.

Error Message: Remove o
Conical tubes

dNTP Reagent Tube seal is
not tight

Tube may be damaged or
defective

Remove and reinstall each dNTP Reagent
Tube.

Make sure that each tube is securely
tightened (finger-tighten), the press OK to
re-check pressure.

If the error message persists, set up
dNTPs in new tubes, secure new tubes on
instrument, then press OK.

If leak check continues to fail, contact
Technical Support.
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Troubleshooting
Instrument error messages

Observation

Possible cause

Recommended action

Error message: There may be a
blockage or no NaOH in W1.
Please check W1 and run line
clear then try again

The waste lines may be blocked

If you are in the auto pH screen, press
Line Clear, otherwise select Tools » Auto
pH » Line Clear from the Main Menu.

Follow the on-screen prompts and use
the syringe provided with the lon Proton™
System.

[Optional/To confirm the Line Clear
procedure was successful, select Flow
Check, then confirm that liquid flows
from both waste lines.

If the flow rates are still not normal,
perform Line Clear one more time.

If the line(s) remain blocked, contact
Technical Support. Otherwise, if
initialization was interrupted, restart
initialization from the beginning.

No NaOH added to Wash 1
Reagent Tube, so chip does not
detect large enough pH
difference between the NaOH
and W2 Solution

Remove the Wash 1 Reagent Tube, rinse

with 18 MQ water, then add 32 pL of 1M

NaOH .

Replace the Wash 1 Reagent Tube and
securely tighten.

Press Restart to restart auto-pH.

Wash 1 or Wash 2 sipper is
loose

Loosen the Wash 1 Reagent Tube, tighten
the sipper, then replace the Wash 1 tube
and securely tighten. Tighten the sipper
as quickly as possible to minimize the gas
flow that occurs when the tube is
removed. (The gas is not harmful to the
NaOH solution and is not a hazard.)

Loosen the Wash 2 cap and re-tighten the
sipper. Tighten the sipper as quickly as
possible to minimize the gas flow that
occurs when the bottle is removed. (The
gas is not harmful to the W2 Solution and
is not a hazard.)

Press Restart to re-start the auto-pH
process.

Error message: UNDERSHOT
TARGET PH: W2 pH = n.nn
Failed

Auto-pH could not add enough
Wash 1 to the Wash 2 before
the maximum iterations, 10,
occurred

. A blockage may have occurred. Follow

the procedure for “Error message: There
may be a blockage or no NaOH in W1.
Please check W1 and run line clear then
try again” on page 48.

Press Restart to re-start auto-pH. If the
"Undershot target pH" error appears
again, replace the chip with a new
(unused) chip and restart auto pH.

Note: The new chip can be used for
sequencing after initialization completes.
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Troubleshooting
Sample loading or sequencing

Observation Possible cause Recommended action
Error message: W2 average not | The waste lines may be blocked | See first recommended action for “Error
stable. Try reseating/replacing message: There may be a blockage or no
chip NaOH in W1. Please check W1 and run line
clear then try again” on page 48.
Reading for W2 Solution is not 1. Remove the chip from the clamp and look
stabilizing quickly enough for damage to the chip, such as hairline

cracks, debris, or a detached flow cell.

e |f the chip is damaged, insert a new
chip in the chip clamp and engage
the clamp (the new chip can be used
for sequencing after initialization
completes).

¢ If no damage can be observed,
reinsert the chip in the chip clamp
and engage the clamp.

2. Loosen the Wash 2 Bottle cap and re-
tighten the sipper. Tighten the sipper as
quickly as possible to minimize the gas
flow that occurs when the bottle is
removed. (The gas is not harmful to the
W2 Solution and is not a hazard.)

3. Press Restart to re-start auto-pH. If auto-
pH fails even after running auto pH with a
new chip, contact Technical Support and
manually adjust the pH of the W2 Solution
as described in “Manually adjust the pH of
the W2 Solution” on page 59.

Error message: W2 out of e Chip measurements very See recommended actions for “Error message:
range unstable W2 average not stable. Try reseating/replacing
chip” on page 49.

e Chipis damaged

Sample loading or sequencing

Observation Possible cause Recommended action
lon PI™ Control lon Sphere™ e Poor chip loading 1. Confirm that the lon PI™ Control lon
particles are not present in the e lon PI™ Control lon Sphere™ particles (included in this
Test Fragment Report section Sphere™ particles were not sequencing kit) were added.
of the run report and library added to the sample 2. If controls were added, contact Technical
sequencing is poor
uencingisp e Chipis damaged Support.
e Instrument failure
Sample results were obtained, e No lon PI" Control lon Check lon PI™ Control lon Sphere™ particles
but poor or no results for lon Sphere™ particles added to | expiry date.
PI™ Control lon Sphere™ the sample
particles in Test Fragment e lon PI™ Control lon
report Sphere™ particles are past

expiry date
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Troubleshooting

Troubleshooting using the lon PI™ Control lon Sphere™ particles

Observation

Possible cause

Recommended action

Good conversion rate for lon
PI™ Control lon Sphere™
particles, but poor sample
loading and sequencing

Problems with library or
template preparation

Verify the quantity and quality of the library and
template preparations. See the /on P/
Template OT2 200 Kit v3 User Guide (Pub. no.
MANO0009133] for recommended quality
assurance procedures.

Troubleshooting using the lon PI" Control lon Sphere” particles

IMPORTANT! To obtain the necessary volume of Ion PI"" Control Ion Sphere’

M

particles for installation or troubleshooting, use the control particles provided with
the Ion PI"" Controls Kit v2 (Cat. no. 4482414) or the Ion PI"" Controls 200 Kit (Cat. no.
4488985) instead of the Ion PI"" Control Ion Sphere™ particles provided with the Ion
PI"" Sequencing 200 Kit v3.

To prepare Ion PI"* Control Ion Sphere particles for an installation or

troubleshooting sequencing run:
1.
2.

50

Create a planned run as described in Chapter 2, “Create a Planned Run”.

Clean and initialize the Ion Proton Sequencer as described in Chapter 3, “Clean
and Initialize the Ion Proton™ Sequencer”.

Prepare the Ion PI"" Control Ion Sphere™ particles for sequencing:

a. Vortex the Ion PI" Control Ion Sphere™ particles for 5 seconds, then
centrifuge for 2 seconds before taking aliquots.

b. Add 66 uL of Ion PI"" Control Ion Sphere ™ particles to an empty 0.2-mL PCR

tube (non-polystyrene).

c. Add 150 pL of Ion PI"" Annealing Buffer to the tube.

Continue to “Anneal Sequencing Primer to the enriched ISPs” on page 32, then
follow the remaining procedures in Chapter 4, “Load the Ion PI Chip v2 and start
the sequencing run” to calibrate and load a chip and start the sequencing run.
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Barcoded Libraries

This appendix describes how to select and create barcode sets on the Ion Proton™
System for sequencing barcoded libraries.

Pre-installed barcode sets

The Torrent Suite” Software includes the pre-installed barcode sets “IonXpress” and
“IonXpressRNA.”

When setting up a Planned Run or performing a run, select the appropriate barcode
set for your library type as follows:

* DNA libraries: Select the IonXpress barcode set, which includes all barcodes in
the Ion Xpress ' Barcode Adapters 1-96 Kits.

* RNA libraries prepared using the Ion Total RNA-Seq Kit v2: Select the
IonXpressRNA barcode set, which contains all 16 barcodes in the Ion Xpress'
RNA BCO01-16 Kit (Cat. no. 4475485).

If you are not using barcodes:

e DNA libraries: Leave the Barcode field blank.

* RNA libraries prepared using the Ion Total RNA-Seq Kit v2: Select
RNA_Barcode_None from the dropdown list. This will ensure that the proper
trimming is performed on the resulting sequence when the RNA library does not
have a barcode.

IMPORTANT! Do not edit, delete, or modify the pre-installed barcode sets.

Select a barcode set for a sequencing run

Select the barcode set in the Torrent Browser when planning the run. See “Create a
planned run” on page 16.

Custom barcode sets

You can create custom sets of barcodes as comma-separated value (.csv) files, then
load these sets onto the Torrent Server for use during sequencing runs.

To access the Ion Proton™ Torrent Server, you must have a username and password.
For more information on working with custom barcode sets, refer to the Torrent
Browser User Interface Guide.
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Appendix B Barcoded Libraries
Other barcode set options

Create and add a
custom barcode
set on the lon
Proton” Torrent
Server

1.

Create the Comma-Separated Variable (.csv) text file of the custom barcode set.
The .csv text file can contain up to 384 barcodes.

To add the custom barcode set to the Ion Proton™ Torrent Server, go to the
Torrent Browser and click the Settings button on the right side of the window,
then select References.

Scroll down to the DN A Barcodes section.
Click Add new DNA Barcodes.

Click the Download the example file link to download an example file to your
computer.

On your computer, edit the .csv example file directly, or use Microsoft® Excel®,
Notepad, or similar software to create a custom barcode set in the same format,
with each barcode sequence listed on a separate line. The barcode list can contain
up to 384 barcodes. Save the .csv file on your computer.

Note: You can run fewer than 384 barcodes in a sequencing run; the Ion Proton
System automatically detects and selects the barcodes used in the run from the
selected set.

Back in the Torrent Browser, enter a name for the barcode set and click Browse to
select the .csv file that you created.

Click Upload & Save. The barcode set file name is displayed in the Barcode
panel.

Other barcode set options

View a barcode set

52

1.

To view a barcode set, go to the Torrent Browser and click the References tab.

2. Scroll down to the Barcodes section and click on the barcode set name to display

the list of barcodes in the set.
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Delete a custom
barcode set from
the lon Proton™
Torrent Server

Add a barcode to a
custom barcode
set

Edit or delete a
barcode from a
set

Appendix B Barcoded Libraries
Other barcode set options

. To view the barcode set names, click the References tab in the Torrent Browser.

. Scroll down to the Barcodes section and click the name of the barcode set that

you want to delete.

. In the barcode set page, click Delete Barcode Set, then click Yes to confirm the

deletion.

. Open the Torrent Browser and click the References tab.

. Scroll down to the Barcodes section and click the name of the barcode set to be

edited.

. Click Add Barcode. You see the new barcode window:

. Complete the fields, then click Save Barcode.

. Open the Torrent Browser, click Settings on the right side of the window, then

select References.

. In the Barcodes panel, click the file name of the barcode set to be edited.

. Click the button under Action to edit or delete the panel.

* To edit a barcode, change the barcode in the edit window, then click Save
Barcode.

e To delete a barcode from a set, click Delete, then click Yes to confirm the
deletion.
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Clean, Initialize,

and Run
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Touchscreen Reference

The Clean, Initialize, and Run programs lead you through the necessary steps to
prepare the instrument for sequencing and start a sequencing run.

¢ The Clean program can be used to perform either 18 MQ water or chlorite

solution cleaning. Cleaning must be performed before each initialization to
ensure that the reagents from the previous run are cleared from the fluid lines.
Abbreviated instructions are provided on the touchscreen; for the complete
cleaning schedule and detailed instructions, see “Cleaning” on page 21.

The Initialize program must be performed before each run to prepare the run
reagents. The Initialize program walks you through the following steps:

— Specifying the sequencing kit.

— Setting up wash solutions. (After this step, the instrument adjusts and checks
the pH of the Wash 2 Bottle solution.)

— Setting up dNTPs. (After this step, the instrument checks the pH of all of the
reagents.)

Abbreviated instructions are provided on the touchscreen; for detailed
instructions, see “Initialization” on page 24.
The Run program walks you through steps leading up to and through
sequencing, including:

— Calibrating a chip before loading the sample on the chip.

— Placing a loaded chip on the instrument.

— Calibrating the loaded chip.

— Selecting a planned run created in the Torrent Server Software.

— Performing sequencing.

For detailed instructions, see Chapter 4, “Load the Ion PI Chip v2 and start the
sequencing run”
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Appendix C Touchscreen Reference
Main menu

¢ The Options menu gives you access to software updates. See “Update Ion Proton™
Sequencer software” on page 59 for details.

* The Tools menu gives you access to troubleshooting tools and to the instrument
Shut Down and Reboot commands. See the following table for details.

Table 3 Tools menu options

Item Description When to use
Auto pH Adjusts the pH of the Wash 2 Bottle solution and checks the |If directed to do so by Technical Support
pH. This task is normally performed by the instrument as or as part of a troubleshooting procedure
part of the Initialize program. (see Appendix A, “Troubleshooting”).
Chip Cal Runs the chip calibration portion of the Run program. Chip If necessary to calibrate chips without
calibration is performed by the instrument as part of the Run | using the Run program.
program, both before and after sample is loaded on a chip.
Data Mgnt | Allows you to manually delete run data or transfer the data | To troubleshoot data management
the server. Under normal conditions, run data is issues. See “Error message: Not enough
automatically transferred to the lon Proton” Torrent Server, | disk space for the necessary number of
then deleted from the instrument hard drive. flows” on page 41.
Noise Provides real-time measurement of electrical noise For troubleshooting if directed to do so by
Screen readings on the chip. Technical Support.
Pressure | Allows you to calibrate the gas pressure after installing a If seeing gas pressure error messages,
Cal new gas tank or to troubleshoot gas pressure error see "Error Message: Confirm Instrument
messages. Has Gas Pressure” on page 40.
Reagent Measures the pH of all reagents on the instrument. This task | If directed to do so by Technical Support
Check is normally performed by the instrument as part of the or as part of a troubleshooting procedure
Initialize program. (see Appendix A, “Troubleshooting”).
Screen Cal | Calibrates the touchscreen. If the touchscreen is not registering
pressure in the correct location. See
“Touchscreen not registering input in
correct location” on page 43.
Shut Down | Access to “Shut Down" and “"Reboot” commands. If directed to do so as part of a

Note: It is not necessary/recommended to shut down the
instrument overnight or over the weekend. If necessary to
shut down the instrument, see “Powering off” on page 58.

troubleshooting procedure.

Chip Status icon

The chip status icon in the lower-left corner of the screen tells you that the chip is

communicating with the instrument and alerts you to chip issues. Shortly after you
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secure a chip in the chip clamp, the chip status should update to "Ready". If the
instrument does not detect the chip, see “Chip is secured in chip clamp, but chip icon
indicates no chip detected” on page 40.

Ready Online Imaging Sleeping No chip
detected

Touchscreen Press the Gauges icon in the lower right corner of the touchscreen to show or hide the
gauges instrument gauges.

Icon Description

Instrument gas pressure. The expected value is 10.50 psi during
cleaning and initialization, and 8.0 during a sequencing run.

If the icon is red, see “Error Message: Confirm Instrument Has
Gas Pressure” on page 40.

Chip compartment temperature. The expected value when the lid
is closed is 35.00 C.

If the icon is red, see “Temperature icon indicates chip
compartment temperature is out of range” on page 40.

Percent instrument hard drive and SSD in use.

If the icon is red, see “Error message: Not enough disk space for
the necessary number of flows” on page 41.

On-instrument analysis.
indicates on-instrument analysis is in progress.
indicates no current on-instrument analysis.

If the icon displays a red "X", see “On instrument analysis icon
indicates error” on page 41.

Alarms/Events If the red Alarms/Events pop-up appears, press the pop-up to see detailed messages.
_ To troubleshoot alarms and events, see “Red "Alarms" and/or "Events" message in
pop-up X
Main Menu” on page 39.
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Supplemental Procedures

Power instrumentonoroff .......... ... ... . i 58
Update Ion Proton” Sequencer SOftware . ................oooeieeuanenen... 59
Manually adjust the pH of the W2 Solution .............................. 59
Set up and test the Ion Chip"™ Minifuge . ...........o.vueriieiennanenen... 60

Power instrument on or off

Powering on Note: If the instrument is powered on, and the touchscreen is blank, touch the screen
to "wake" the touchscreen.

1. Locate the power switch on the back of the instrument, then power on the
instrument.

2. Press the power button on the front of the instrument.
When the instrument touchscreen Main Menu first comes up, it will appear dim.
After a few minutes, the main menu will be brightly lit, indicating that the
instrument is ready for use.

3. If reagents were left on the machine for more than 48 hours, and the Clean
program was not run with 18 MQ) water before powering off, run the Clean
program with chlorite before initializing the instrument and performing a
sequencing run.

Powering off It is not necessary to power off the instrument overnight or over the weekend. If the
instrument will not be used for more than 3 days, then power off the instrument as
follows:

1. If powering off for more than 3 days, run the Clean program with 18 MQ water
before powering off.

2. In the Main Menu, select Tools » Shut Down » Shut Down.

Note: Select Tools » Shut Down » Reboot if you want the instrument to shut
down and immediately restart.
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Update lon Proton” Sequencer software

IMPORTANT! After updates are installed, the instrument must be restarted.

If an update to the Ion Proton " Sequencer software is available, the red "Alarms and
Events" pop-up appears in the touchscreen Main Menu to alert you. Click the red
pop-up to see the detailed messages. If a message states New Software
Available, update the software as follows:

1. In the Main Menu, select Options » Updates.
2. Select the Released Updates checkbox, then press Check.

3. When the message Press Update to begin update process appears,
press Update.

Note: If the message A1l Software Current appears, press Back, Back to
return to the main menu.

4. When the message Installing Completed displays, follow the onscreen
prompts to restart the instrument.

Note: In some cases, the instrument restarts automatically after software
installation.

Manually adjust the pH of the W2 Solution

Materials and equipment needed
e Orion® 3-Star Plus pH Benchtop Meter Kit or equivalent
* Nitrogen gas tank, tube, and flow meter
* 1M NaOH (prepared fresh daily)
* Pipette tips and pipette
* Magnetic stirrer and stir bar
¢ 100 mM HCI
* Squirt bottle
If an error message during the automatic pH process indicates that there is a problem

adjusting the pH of the W2 Solution, use the following procedure to manually adjust
the pH of the W2 Solution in the Wash 2 Bottle.

1. Before proceeding, rinse an empty Wash 2 Bottle and have it ready next to the
instrument. Also have an additional Wash 2 Bottle cap ready.

Note: Gas will be flowing out of the Wash 2 cap, so perform the next steps as
quickly as possible (flowing gas will not harm the W2 Solution, and is not a
hazard).

2. Remove the Wash 2 Bottle attached to the instrument, and cap the bottle.
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3. Secure the empty Wash 2 Bottle (from step 1) to the instrument. Do not remove
the sipper. This bottle will contain the gas flowing out of the instrument while
you adjust the pH of the W2 Solution and protect the sipper from contamination.

4. Move the Wash 2 Bottle containing the W2 Solution to the stir plate near the
nitrogen gas tube.

5. Secure the gas tube so that it extends inside the mouth of the Wash 2 Bottle but
not below the surface of the W2 Solution.

6. Set the gas flow to 0.5 Ipm. Start mixing the W2 Solution fast enough for a small
whirlpool to form.

7. Calibrate the pH meter using a three-point calibration. Rinse any buffering
solution from the pH probe prior to preparing solutions.

8. Adjust the pH of the W2 Solution to 7.7 + 0.1 by adding a small amount
(approximately 1 uL) of freshly prepared 1 M NaOH to the solution, and then
measuring the pH using the pH meter. Add small aliquots and allow the pH to
equilibrate before adding more.

Note: If the pH rises above 7.8, use 100 mM hydrochloric acid (HCI) to readjust
the pH to 7.7 + 0.1.

9. When the pH is stable, turn off the gas, remove the gas line, and cap the Wash 2
Bottle.

10. Move the bottle to the instrument, remove the empty Wash 2 Bottle from the
instrument, and place the sipper inside the Wash 2 Bottle containing the pH-
adjusted solution.

11. Secure the cap firmly. Press Next to exit the automated pH check and continue
with instrument initialization.

Set up and test the lon Chip" Minifuge

Before using the Ion Chip" Minifuge (Cat. no. 4479672 or 4479673) for the first time:
e Install the Ion Proton " Rotor and Buckets (Cat. no. 4482578).
¢ Test the minifuge to confirm that no liquid is lost during centrifuging.

Install the lon 1. Grasp the existing rotor and pull straight up to remove the rotor from the motor
Proton” Rotor and shaft.
Buckets
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2. Press the Ion Proton Rotor down onto the motor shaft to install.

3. Tighten the set screw with a 1.5-mm hex wrench.

4. Install the two buckets. Position the buckets with the larger semi-circular cut-
outs facing out, and ensure that the buckets hang freely.
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Test the lon ChipTM 1. Prepare 2 previously-used chips:

Minifuge a. Inject 100 puL isopropanol two times into the loading port of each chip. After
each injection, remove the expelled liquid from the opposite port.

b. Aspirate the remaining isopropanol from the chip flow cells for 5-10
seconds. Confirm that the chips are dry.

Note: To aspirate the isopropanol, attach a P200 pipette tip to a vacuum
line, then place the pipette tip in the chip loading port.

2. Place the two chips prepared in step 1 in the centrifuge buckets, with the chip
notch pointing out. Add 55 uL nuclease-free water to each chip loading well (do
not inject into the chip loading port).
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Chip notch

Chip notch

3. Centrifuge for 5-10 seconds, then examine each chip.
Note: A small volume of liquid will remain in the loading well; this is normal.
The flow cell in each chip should be completely filled with liquid with no air
bubbles.
* If the chips are NOT completely filled, contact Technical Support.

 If the chips ARE completely filled: Centrifuge the chips for an additional 10
minutes, then check the chips again for air bubbles, especially near the inlet
and outlet ports. After 10 minutes, if the chips are:

— Still completely filled: The centrifuge is ready to use for Ion PI"" Chip v2
loading.
— If chips have air bubbles: Contact Technical Support.
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Equipment use

Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the
instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

- Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, etc). To obtain SDSs, see the “Documentation and
Support” section in this document.

The Ion Proton” System is for performing sequencing of amplified DNA, and should
only be used for life science research applications. The Ion Proton " System should
only be used by professionals trained in laboratory techniques and who have studied
the instructions for use of this instrument. If the equipment is used in a manner not
specified by the manufacturer, the protection provided by the equipment may be
impaired.

IMPORTANT! If you use and/or install the Ion Proton™ System in an unspecified
manner, you may impair the protection provided by the equipment.

Symbols on this instrument

64

Symbols may be found on the instrument to warn against potential hazards or convey
important safety information. In this document, the hazard symbol is used along with
one of the following user attention words:

* CAUTION! - Indicates a potentially hazardous situation that, if not avoided,
may result in minor or moderate injury. It may also be used to alert against
unsafe practices.

* WARNING! - Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

* DANGER! - Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury.
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Symbol

English

Francais

Caution, risk of danger

Consult the manual for further safety
information.

Attention, risque de danger

Consulter le manuel pour d'autres
renseignements de sécurité.

®

Protective conductor terminal (main
ground)

Borne de conducteur de protection
(mise a la terre principale)

(|

I:

Do not dispose of this product in
unsorted municipal waste

CAUTION! To minimize
negative environmental
impact from disposal of
electronic waste, do not
dispose of electronic waste in
unsorted municipal waste.
Follow local municipal waste
ordinances for proper
disposal provision and
contact customer service for
information about
responsible disposal options.

Ne pas éliminer ce produit avec les
déchets usuels non soumis au tri
sélectif.

CAUTION! Pour minimiser
les conséquences négatives
sur Uenvironnement a la suite
de l'élimination de déchets
électroniques, ne pas
éliminer ce déchet
électronique avec les déchets
usuels non soumis au tri
sélectif. Se conformer aux
ordonnances locales sur les
déchets municipaux pour les
dispositions d’élimination et
communiquer avec le service
a la clientele pour des
renseignements sur les
options d’élimination

responsable.
Conformity Conformity mark Description
symbols on this
instrument Indicates conformity with safety

requirements for Canada and U.S.A.

Indicates conformity with European
Union requirements for safety and
electromagnetic compatibility.

Indicates conformity with Australian
standards for electromagnetic
compatibility.

Safety alerts on this instrument

Additional text may be used with one of the symbols described above when more
specific information is needed to avoid exposure to a hazard. See the following table
for safety alerts found on the instrument.
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English

French translation

CAUTION! Hazardous chemicals.
Read the Safety Data Sheets (SDSs)
before handling.

ATTENTION! Produits chimiques
dangereux. Lire les fiches signalétiques
(FS) avant de manipuler les produits.

CAUTION! Hazardous waste. Refer
to SDS(s) and local regulations for
handling and disposal.

ATTENTION! Déchets dangereux. Lire les
fiches signalétiques (FS]) et la
réglementation locale associées a la
manipulation et a l'élimination des déchets.

Safety symbols
used on the
instrument

66

Safety and regulatory
symbols
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Safety information for instruments not manufactured by Life
Technologies Corporation

Some of the accessories provided as part of the instrument system are not designed or
built by Life Technologies Corporation. Consult the manufacturer's documentation
for the information needed for the safe use of these products.

Instrument safety

General

CAUTION! Do not remove instrument protective covers. If you remove the
protective instrument panels or disable interlock devices, you may be exposed
to serious hazards including, but not limited to, severe electrical shock, laser
exposure, crushing, or chemical exposure.

CAUTION! Solvents and Pressurized fluids. Wear eye protection when
working with any pressurized fluids. Use caution when working with any
polymeric tubing that is under pressure:

- Extinguish any nearby flames if you use flammable solvents.
- Do not use polymeric tubing that has been severely stressed or kinked.

- Do not use polymeric tubing with tetrahydrofuran or nitric and sulfuric
acids.

- Be aware that methylene chloride and dimethyl sulfoxide cause polymeric
tubing to swell and greatly reduce the rupture pressure of the tubing.

- Be aware that high solvent flow rates (~40mL/min) may cause a static charge
to build up on the surface of the tubing and electrical sparks may result.

Electrical

WARNING! Ensure appropriate electrical supply. For safe operation of the
instrument:

- Plug the system into a properly grounded receptacle with adequate current
capacity.

- Ensure the electrical supply is of suitable voltage.

- Never operate the instrument with the ground disconnected. Grounding
continuity is required for safe operation of the instrument.

WARNING! Power Supply Line Cords. Use properly configured and approved
line cords for the power supply in your facility.

WARNING! Disconnecting Power. To fully disconnect power either detach or
unplug the power cord, positioning the instrument such that the power cord is
accessible.
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Cleaning and
decontamination

Gas safety

CAUTION! Cleaning and Decontamination. Use only the cleaning and
decontamination methods specified in the manufacturer's user documentation.
It is the responsibility of the operator (or other responsible person) to ensure
the following requirements are met:

- No decontamination or cleaning agents are used that could cause a
HAZARD as a result of a reaction with parts of the equipment or with
material contained in the equipment.

. The instrument is properly decontaminated a) if hazardous material is
spilled onto or into the equipment, and/or b) prior to having the instrument
serviced at your facility or sending the instrument for repair, maintenance,
trade-in, disposal, or termination of a loan (decontamination forms may be
requested from customer service).

- Before using any cleaning or decontamination methods (except those
recommended by the manufacturer), users should confirm with the
manufacturer that the proposed method will not damage the equipment

Verify that your installation room can accommodate gas cylinders.

WARNING! Instrumentation must be installed and operated in a well-
ventilated environment as defined as having a minimum airflow of 6-10 air
changes per hour. Assess the need for ventilation or atmospheric monitoring to
avoid asphyxiation accidents from inert gases and/or oxygen depletion, and
take measures to clearly identify potentially hazardous areas through training
or signage. Please contact your Environmental Health and Safety Coordinator
to confirm that the instruments will be installed and operated in an
environment with sufficient ventilation.

WARNING! Pressurized gas cylinders are potentially explosive. Always cap
the gas cylinder when it is not in use, and attach it firmly to the wall or gas
cylinder cart with approved brackets or chains.

WARNING! Gas cylinders are heavy and may topple over, potentially causing
personal injury and tank damage. Cylinders should be firmly secured to a wall
or work surface. Please contact your Environmental Health and Safety
Coordinator for guidance on the proper installation of a gas cylinder.

Safety and electromagnetic compatibility (EMC) standards

68

The instrument design and manufacture complies with the standards and
requirements for safety and electromagnetic compatibility as noted in the following
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Safety and electromagnetic compatibility [EMC) standards

Safety Reference

Description

EU Directive 2006/95/EC

European Union “Low Voltage Directive”

IEC 61010-1
EN 61010-1
UL 61010-1
CSA C22.2 No. 61010-1

Safety requirements for electrical
equipment for measurement, control, and
laboratory use - Part 1: General
requirements

IEC 61010-2-010
EN 61010-2-010

Safety requirements for electrical
equipment for measurement, control and
laboratory use — Part 2-010: Particular
requirements for laboratory equipment for
the heating of materials

EMC Reference Description
Directive European Union “EMC Directive”
2004/108/EC
EN 61326-1 Electrical Equipment for Measurement, Control and Laboratory

Use - EMC Requirements - Part 1: General Requirements

FCC Part 18 (47 CFR] | U.S. Standard “Industrial, Scientific, and Medical Equipment”

AS/NZS 2064 Limits and Methods of Measurement of Electromagnetic
Disturbance Characteristics of Industrial, Scientific, and Medical
(ISM] Radjofrequency Equipment

ICES-001, Issue 3 Industrial, Scientific and Medical [ISM) Radio Frequency
Generators

Environmental Reference

Description

design
Directive 2002/96/EC

European Union "WEEE Directive” - Waste
electrical and electronic equipment
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Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below, and consult the relevant
SDS for specific precautions and instructions:

- Read and understand the Safety Data Sheets (SDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

- Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

- Minimize the inhalation of chemicals. Do not leave chemical containers open.
Use only with adequate ventilation (for example, fume hood).

- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow
the manufacturer's cleanup procedures as recommended in the SDS.

- Handle chemical wastes in a fume hood.

- Ensure use of primary and secondary waste containers. (A primary waste
container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

- After emptying a waste container, seal it with the cap provided.

- Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

- Ensure that the waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

- IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.

WARNING! HAZARDOUS WASTE (from instruments). Waste produced by
the instrument is potentially hazardous. Follow the guidelines noted in the
preceding General Chemical Handling warning.

WARNING! 4L Reagent and Waste Bottle Safety. Four-liter reagent and waste

bottles can crack and leak. Each 4-liter bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in
the upright position.

Specific chemical

CAS Chemical information

handling

26628-22-8 Sodium Azide |Sodium azide may react with lead and copper

plumbing to form highly explosive metal azides.

70
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Biological hazard safety

WARNING! Potential Biohazard. Depending on the samples used on this
instrument, the surface may be considered a biohazard. Use appropriate
decontamination methods when working with biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. All work should be conducted in properly
equipped facilities using the appropriate safety equipment (for example,
physical containment devices). Safety equipment also may include items for
personal protection, such as gloves, coats, gowns, shoe covers, boots,
respirators, face shields, safety glasses, or goggles. Individuals should be
trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow
all applicable local, state/provincial, and/or national regulations. The following
references provide general guidelines when handling biological samples in
laboratory environment.

- U.S. Department of Health and Human Services, Biosafety in Microbiological
and Biomedical Laboratories (BMBL), 5th Edition, HHS Publication No. (CDC)
21-1112, Revised December 2009; found at:
www.cdc.gov/biosafety/publications/bmbl5/BMBL.pdf

- World Health Organization, Laboratory Biosafety Manual, 3rd Edition,
WHO/CDS/CSR/LYO/2004.11; found at:

www.who.int/csr/resources/publications/biosafety/Biosafety7.pdf
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Documentation and Support

Obtaining Certificates of Analysis

The Certificate of Analysis provides detailed quality control and product qualification
information for each product. Certificates of Analysis are available on our website. Go
to www.lifetechnologies.com/support and search for the Certificate of Analysis by
product lot number, which is printed on the box.

Obtaining SDSs

Safety Data Sheets (SDSs) are available from www.lifetechnologies.com/support.

Note: For the SDSs of chemicals not distributed by Life Technologies Corporation,
contact the chemical manufacturer.

Obtaining support

For the latest services and support information for all locations, go to:
www.lifetechnologies.com/support

At the website, you can:

¢ Access worldwide telephone and fax numbers to contact Technical Support and
Sales facilities

* Search through frequently asked questions (FAQs)
* Submit a question directly to Technical Support (ionsupport@lifetech.com)

* Search for user documents, SDSs, vector maps and sequences, application notes,
formulations, handbooks, certificates of analysis, citations, and other product
support documents

¢ Obtain information about customer training

* Download software updates and patches

lon contact information

Web site: lifetechnologies.com/iontorrent
Ion community: ioncommunity.lifetechnologies.com

Support email: ionsupport@lifetech.com
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Documentation and Support
Limited product warranty

Phone numbers
In North America: 1-87-SEQUENCE (1-877-378-3623)
Outside of North America: +1-203-458-8552

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale found on Life
Technologies' website at www.lifetechnologies.com/termsandconditions. If you have
any questions, please contact Life Technologies at www.lifetechnologies.com/
support.
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5791 Van Allen Way | Carlsbad, CA 92008 USA | Phone +1 760 603 7200 | Toll Free in USA 800 955 6288

For support visit lifetechnologies.com/support or email techsupport@lifetech.com technologies”

lifetechnologies.com
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